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1. Chem Sketch 
A. Introduction 
This is an introduction to the program ChemSketch, from ACD Labs. You can use 
ChemSketch to draw chemical structures, and to view them as three dimensional 
(3D) models. 
The approach in this tutorial is to show by example. I will lead you through one 
example in some detail, showing how to draw the structure, and how to convert it to 
3D. After that, I will briefly show some other features. 
No attempt is made here to teach all of ChemSketch. The idea is to guide you to 
some basics. If you can do the things shown here, you should then be ready to pursue 
more features of the program on your own -- as you need them. 

 
B. Getting and installing ChemSketch 
Requirements. ChemSketch should run under Windows versions from Windows 
2000 onwards. (I am running v 2016 1.1 with Windows 10, 64 bit.) 
If you want to run ChemSketch with other systems, see Notes: Requirements and 
versions. 
Obtaining ChemSketch. Go to https://www.acdlabs.com/resources/free-
chemistry-software-apps/. Choose ACD ChemSketch Freeware. 
The current version is 2016, originally posted at their web site November 2016. 
(According to the ChemSketch "About" screen, the specific program version is now 
2016 1.1, dated July 2016.) If you find a more recent version, please contact me, and 
I will update these instructions as needed. 

Installation. Install ChemSketch by running the exe file that you downloaded. The 
installation program installs two programs, ChemSketch itself and a program called 
3D. ChemSketch is the drawing module, and 3D is the module for viewing 3D 
structures. ChemSketch is introduced in Section C below, and 3D is introduced 
in Section E. More about how these two programs (or "modules") interact with each 
other in Sections E and I. 

Settings. ChemSketch will run fine "out of the box". However, there are things one 
can set as you wish; they are on the Options menu, choose Preferences. Version 11 
introduced one setting that may well be worth a try. On the General tab, click Use 
Antialiasing. This feature will result in less jagged lines on the screen output. More 
information about this feature is in the section Antialiasing, but it is probably ok to 
just turn it on. Whether it is on or off by default varies with the version; in 
version 14, it seems to be off. 
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C. Drawing your first molecule 
In this section, you will draw a simple organic molecule, to get started with the basic 
features of ChemSketch. The molecule is propane, CH3CH2CH3. 
Open ChemSketch (for example, by clicking on its icon). 

 

Fig. Screen shot of the upper left hand 
corner of the opening screen. 
Two of the tool buttons are already "lit 
up" when you open ChemSketch. One 
of these is along the left side, labeled 
C, for carbon. The other is a tool that 
looks something like a pencil drawing 
a line, along the 2nd horizontal row of 
tools near the 20-25 tics on the ruler. 
This tool, named "Draw Normal", is 
the tool you use for ordinary drawing. 
Also, ChemSketch is in "structure" 
mode, as indicated by the word 
"Structure" being lit up (upper row of 
buttons, at left). 
All of the settings mentioned here 
should be ok when you first open 
ChemSketch. However, if you change 
them, you may need to get back to 
them. 

Single click anywhere on the main screen. You should see CH4 appear on the screen. 

Position the pointer over that CH4. You will know when the pointer is properly 
positioned because a faint box will appear around the C atom (along with its 
hydrogens). Single click. You should now see H3C-CH3 (which is ethane). 

Position the pointer over either C-region of that H3C-CH3. You will know when the 
pointer is properly positioned because a faint box will appear around the C atom you 
have chosen (along with its hydrogens). Single click. You should now see a 2D 
structure of propane (Fig 3): 

 

Fig 3. Propane. 
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Lessons from this section -- the basic tools of ChemSketch: 
As you draw the propane structure, note the following general points... 
To add a Carbon, you click on the place where you want it added. You use the C tool 
-- the default-- for this. 
Each time you add a C, the number of hydrogens shown will adjust appropriately. 
With these simple tools, you are drawing molecules of C and H. 
 
D. 3D structures – introduction 
At this point, you have a 2D structure on the screen in ChemSketch. You want to 
convert it to a 3D structure. There are two ways to do this; these are described in the 
following two sections. You can use either of them; they both work fine, and are 
approximately equivalent in ease and features. If you are just playing around to see 
some structures, it may be simplest to stay within ChemSketch (Section E). On the 
other hand, if you are already familiar with RasMol, you might prefer to save the 
structure in a file format that RasMol can read (Section F). 
 
E. 3D structures, within ChemSketch 
1. Convert the 2D drawing to 3D. To do this, go to Tools menu, and choose 3D 
Structure Optimization. Alternatively, you can click the button near the right end 
of the second toolbar; the button looks like a model of CH4 and lights up with the 
name 3D Optimization. On my computer, it is "off the screen", and I have to choose 
>> ("more buttons") to get to it. (Note that this step is the same whichever method 
you use for getting a 3D view.) 

If you want to do further editing of the structure, first undo the 3D optimization. Go 
to the Edit menu, and choose Undo 3D optimization. 

2. Click on the rectangular button labeled Copy to 3D, near lower left corner of 
screen (Fig 4, below). ChemSketch will now switch to the 3D module, and display 
the molecule you have drawn. 

If you do not see the Copy to 3D button, it means you have not yet opened the 3D 
Viewer program. That is ok; just go open it now. You can open 3D Viewer by 
clicking on the 3D Viewer tool button near the right end of the upper tool bar. On 
my computer, it is "off the screen", and I have to choose >> ("more buttons") to get 
to it. Clicking this button opens 3D Viewer, and copies the current structure to that 
module. Another way to open the 3D Viewer is to go to the ACD/Labs menu, and 
choose 3D Viewer. (Be sure you have done the 3D optimization before copying to 
3D.) 



5/20 
 

If you do not see the 3D Viewer tool button, you may need to add it to the toolbar. 
To do that, click on the odd symbol at the right hand end of the upper toolbar; the 
symbol looks like a hyphen with a down-arrowhead under it. You will get a list of 
buttons. Near the bottom is "3D Viewer". Click it, to add it to the toolbar. (This also 
lets you see what the button looks like.) 

 

Fig Screen shot of the lower left hand 
corner of the ChemSketch screen -- after 
the 3D Viewer has been opened. If you do 
not see the buttons described here, see the 
paragraphs immediately above. 
 
Note the Copy to 3D and 3D 
View buttons, above/right of the Start 
button (which is shown in its default, most 
common, location at the lower left of the 
screen), and three lines below the default 
palette. (Also note the button there 
labeled ChemSketch. When you are in 
the 3D module, this button at the lower 
left, near Start, lets you switch back to the 
ChemSketch module.) 

You can view and manipulate the 3-dimensional structure, in the 3D module. As 
examples... 
- Go to the View menu, and choose Balls & Sticks. (You can also use the tool button 
that lights up with that name.) 
- To rotate the structure, hold down the left mouse button while moving the mouse. 

Double bonds may or may not show in the 3D module -- depending on the "view". 
(Drawing of double bonds is introduced in a section below: Double bonds 
(propene).) They show in Wireframe view, but not the other views. The geometry 
that is shown is correct, taking into account the double bond, but the doubleness of 
the bond per se is not shown in some views. (This is true for many viewing 
programs.) If you want to see the double bonds, you might also try viewing the 
structure in RasMol. To do this, see the next section: 3D structures, for RasMol. For 
a discussion of showing double bonds in RasMol, see the RasMol page, 
Cyclohexene. 
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Now that you know about the role of the 3D program... You can load both 3D and 
ChemSketch at once, by originally opening 3D. That is, loading the 3D program 
automatically loads ChemSketch (but not the other way). If you do this, you will 
need to click on the "ChemSketch" button at the bottom left to get to ChemSketch. 

 
F. 3D structures, for RasMol 

This section describes another way to make a 3D version of the 2D structure you 
drew in ChemSketch. It saves the file in a format that can be read by RasMol. This 
method requires using one more program, but may be useful if you are already 
familiar with RasMol. 

There are three steps: 

1. Convert the 2D drawing to 3D. To do this, go to Tools menu, and choose 3D 
Structure Optimization. Alternatively, you can click the button near the right end 
of the second toolbar; the button looks like a model of CH4 and lights up with the 
name 3D Optimization. On my computer, it is "off the screen", and I have to choose 
>> ("more buttons") to get to it. (Note that this step is the same whichever method 
you use for getting a 3D view.) 

2. Save the file in the MOL format, which RasMol can read. To do this, go 
to File menu, and choose Save As. At the bottom of the Save As dialog box, 
choose file format = MDL Molfiles (V2000) (*.mol). Give the file a name of your 
choice, and click Ok to save it. (In previous versions, there was only one option for 
MDL Molfiles; now you need to choose V2000.) 

Prior to version 10, this step was done using Export, rather than Save As. Now, 
either command will work. That is, the functions of Export are now duplicated in 
Save As. Since Save As is the more conventional command, I recommend using it. 

3. Open the file in RasMol. To do this, load RasMol. Go to the File menu, and 
choose Open. Open the selector box at the bottom, showing Files of Type:, and 
choose MDL Mol File Format. Now find the Mol file that you saved in Step 2, above, 
and Open it. Except for this one special step, specifying the file type, viewing the 
file in RasMol is entirely normal. See the RasMol page for information on this 
program. 
G. Drawing in ChemSketch -- more basic features 
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This section will show you how to draw some other molecules. Each example will 
introduce one new feature of using ChemSketch. The instructions in this section will 
help you draw the 2D structure, as you did for propane (Section C, above). Then you 
can convert to 3D, as you did before [Sections D (introduction), E (within 
ChemSketch), F (making files for RasMol)]. The instructions for converting to and 
viewing in 3D above work for all structures drawn in ChemSketch. 

1. Double bonds (propene) 

Propene (propylene; CH2=CH-CH3) differs from propane in having a double bond. 
The drawing strategy is to draw propane, then change one C-C single bond to a 
double bond. 

First, draw propane, as described above in Section C. 

Now, put the pointer on one of the C-C bonds in the propane structure. You will 
know when the pointer is properly positioned, because a faint box will appear around 
the bond. Single click. The bond will change to a double bond, and the CH3 will 
change to CH2. You now have the 2D structure for propene (Fig 5): 

 

Fig 5. Propene. 

Each time you click on a bond, it will increase from single to double to triple bond, 
or will change from triple back to single. Just click on the bond over and over, and 
you will toggle among these choices. 

2. Heteroatoms (ethanol) 

The "skeleton" of ethanol (ethyl alcohol; CH3CH2OH) differs from propane in 
having an O atom instead of one of the C atoms. That is, ignoring the hydrogens, 
propane is C-C-C and ethanol is C-C-O. The drawing strategy is to draw propane, 
then change one carbon atom to an oxygen atom. 

A "heteroatom" is an atom other than C or H. Chemistry drawing programs usually 
draw C atoms by default, and they usually provide the proper number of hydrogen 
atoms. It is up to the user to specify atoms other than C or H. 

First, draw propane, as described above in Section C. 
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Now, click on the O tool (for oxygen), on the toolbar along the left side; the O tool 
will light up. (The O tool is a little below the C tool, which you have been using so 
far, by default.) Then, put the pointer on one of the C atoms at either end of the 
propane structure. You will know when the pointer is properly positioned, because 
a faint box will appear around the atom (with its hydrogens). Single click. The C 
will change to an O, and the number of hydrogens will adjust appropriately. That is, 
the CH3 will change to OH. You now have the 2D structure for ethanol (Fig 6): 

 

Fig 6. Ethanol. 

This illustrates the general procedure for changing one atom to another in a 
ChemSketch structure. 

In this case, if you changed the middle C to an O, you would make dimethyl 
ether, H3C-O-CH3. 

If the heteroatom you want is not shown at the left, click on the periodic table button 
at the top of that column of tool buttons (just left of the "mm"; see Fig 2); it lights 
up as "Periodic Table of Elements". Choose the element you want from the periodic 
table. (The elements directly available at the left, with their own tool buttons, will 
vary.) 

3. Rings and templates 

ChemSketch provides templates of several "complex" structures, allowing you to 
add these structures as a unit. We illustrate that here with a ring. 

Go to Templates menu, and choose Table of Radicals. (You can also reach this by 
pressing F6. There is also a tool button for this feature: it is along the right side, just 
below the ruler and just above tool buttons for some specific ring templates; it lights 
up as Table of Radicals.) 

Find the section of the Table of Radicals called Cycles. Move the pointer to the 
benzene ring, and click on it. You will now be returned to the main screen. Position 
the pointer as desired, and single click. The benzene ring will be put on the screen. 

The pointer will still carry the benzene ring. To add a second benzene ring to 
your structure, position the pointer over any specific atom of the first ring, 
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and single click. To fuse two rings, position the pointer over a bond in one ring, and 
single click. 

 

Fig. 2-phenylnaphthalene, drawn using 
the benzene ring template. Steps... 
Select the benzene ring template. 
Lay down ring #1, at the left. 
Lay down ring #2 at a specific atom on 
the first ring. 
Lay down ring #3 at a specific bond in 
#2. 

And the pointer still carries the benzene ring! How do you get it to stop? Click 
something else. For example, you might click the C tool, at the left, to go back to 
adding individual carbon atoms. (Or, click on the lasso tool, so the pointer no longer 
carries anything. You can also right click, but this does not work for other tools, such 
as the common C tool.) 

 
H. Lewis structures (more templates) 

Briefly noted. The topic seems to not be in the help file at all. 

Some aids for drawing Lewis structures are available on templates. Go 
to Templates menu, choose Template Window. Choose the Lewis 
structures or Reaction symbols template. (If either is not listed at the left, explore 
the drop down menu, near top left.) 

The Lewis structures template offers several pre-drawn structures, as well as an 
assortment of dots and/or x's, which you can position as you wish. The Reaction 
symbols template offers a small number of symbols, but perhaps of a more 
convenient size. I suggest you explore what both templates offer. Note that 
the Lewis structures template has a second page, with some instructions. 

 
I. Interactions between the ChemSketch and 3D modules 

The above sections presented certain specific sequences of using the two modules, 
ChemSketch and 3D. As you become familiar with these two modules, you will learn 
that there is considerable flexibility about how you use them. Some points... 
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You can open either program or both programs in any order. It doesn't really matter. 
Open whatever you want whenever you want. But hint: If you know you want both, 
open 3D first; it automatically opens ChemSketch along with it. 

If both programs are open, you can switch between them using the buttons at the 
lower left corner (Figure). If those buttons do not appear, it means that you have not 
yet opened the other module. If one program is open, the easy way to open the other 
one is from the ACD/Labs menu. 

Caution. The "Copy to 3D" function does not seem to know whether you actually 
have a 3D structure. It will allow you to transfer a 2D drawing to the 3D module. 
So, the mere fact that you are in the 3D module does not mean that you have a proper 
3D structure. Be sure to carry out the 3D Structure Optimization. The good news 
is that you can actually do this within either module. In the 3D module, the 3D 
Structure Optimization function is available from the Tools menu or a tool button. 
(This function is labeled both 3D Structure Optimization and 3D Optimization, 
in various places.) 

 
J. Stereochemistry: Drawing cis-trans isomers at double bonds 

Sometimes you want a particular group to point in a certain direction, and the 
drawing program may insist it point in another direction. This section presents one 
simple but versatile little trick to deal with this. The specific example is drawing cis-
2-butene. By default, ChemSketch seems to want to draw the trans isomer. 

Here is how you can draw the cis isomer. This is illustrated in Fig 8, below. The 
three parts of the figure represent three stages in the drawing. To make the figure, I 
copied each stage into a new position, so you could see each stage. But normally you 
would just do all the steps sequentially on one drawing. 
1. Draw 2-butene, following the usual procedures. This gives you (a) in the figure. 
The problem is that the right hand methyl group points down, and you want it to 
point up. 
2. Add one more methyl group -- the one that points up. This gives you (b) in the 
figure. 
3. Remove the lower methyl group, the one you do not want. To do this, choose 
the lasso tool (upper toolbar, near left); using this tool, select the group you want to 
remove; then remove it with CTRL/X or delete. Now you have (c) in the figure, the 
desired cis-2-butene. 
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Fig. How to draw a 
specific cis-trans 
isomer. 

The procedure described above is useful whenever you want a group to point in a 
specific direction different from the program default. For example, you may be 
simply drawing an extended alkyl chain, but want it oriented a certain way. 

  
K. Stereochemistry: Wedge bonds 

Wedge bonds allow you to specify that an attached atom is above or below the plane. 

Fig 9, below, shows an example. In this example, wedge bonds are used to show a 
specific stereoisomer at a stereocenter. This was done in three stages. First, I drew 
an ordinary structure for bromochloroiodomethane (that is, a C with Br, Cl, I, H 
attached). This is shown at the left. Then, I made two copies of this, on the right. 
(The copies were for my convenience in making the figure. In normal use, you would 
just modify the original.) In the top right copy, I changed two of the bonds to up 
wedges and two to down wedges. In the lower right copy, I did something similar, 
but switched which bonds are up and which are down. 

Procedure for changing an ordinary bond to a wedge bond: To do this, choose a 
wedge bond tool, and then click on the desired bond. The wedge bond tools are at 
about 50 on the tool bar just above the ruler; see Fig 2. The solid wedge ("Up Stereo 
Bonds") is for a bond pointing up, and the dashed wedge ("Down Stereo Bonds") is 
for a bond pointing down. You can also use the wedge bond tools to draw new bonds. 

I have named the structures in Fig 9, using the naming feature of ChemSketch. I 
showed the names here so you can see that the left hand structure does not get an 
R/S designation, and the two right hand structures do get R/S designations. Convince 
yourself that these are correct. The procedure for getting the names is shown below 
in the section Naming structures. 
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Fig. Screen shot to 
show wedge 
bonds. 
Explanation is 
above. 

Caution. ChemSketch will put wedges wherever you tell it to -- even if they are 
physically unreasonable. For example, you could draw all four bonds around a C 
with up wedges -- which is not possible. The ChemSketch naming procedure will 
not put an isomer designation on such an improper structure. 

 
L. Unusual atoms labels (X for halogen, Me, etc) 

Sometimes you want to label an "atom" (a particular position on a structure) with 
something other than an ordinary element symbol. Examples include: D for 
deuterium, X for a general halogen, Me for methyl. 

The symbols D and T, for the hydrogen isotopes, are available from the regular 
periodic table (near its lower right). That periodic table was introduced above near 
the end of the section on Heteroatoms (ethanol). 

A more general way to insert an unusual "symbol" is the feature Edit Atom Label. 
This tool is on the left tool bar -- but off the screen. So, expand the left tool bar (>> 
= "more buttons") and look for the button labeled abc; it will light up as Edit Atom 
Label. Click on the abc button; the cursor will now have an odd symbol starting with 
ab attached to it. Click on the atom you want to change (or anywhere on the drawing 
screen). A new box opens, called Edit Label. You now have two main choices: First, 
you can type in the label you want, and press insert. Or you can choose an item from 
the list there, and press insert. 
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M. Showing charges 

How does one make a charged species, such as the acetate ion shown in the following 
figure? 

 

Fig 10. Screen shot to show an example of a 
structure with a charge on an atom. 
Left: acetic acid 
Right: acetate ion 

The general approach is to draw the neutral molecule first, then change the charge 
as needed. We will assume you know how to draw the neutral molecule, acetic acid 
(left) in this case. 

Here are two ways to change the charge. The first is simpler for this case; the 2nd is 
more general. 

Both use functions on the left-hand column of buttons. If you do not see the desired 
button, right-click in the column, and you will get a nice readable list of the buttons, 
well labeled. 

Method 1. Use the "decrement charge" button. You may see instead an "increment 
charge" button (with a red + on it). If so, click on the little lit-up corner (lower right), 
and choose the - option. The button will now be for "decrement charge". Click on it, 
and then click on the O of interest. That should give you the desired ion. (Note that 
ChemSketch, by default, adjusts the number of H shown to fit.) 

Method 2. Use the "atom chemical properties" button. Click on it, and then click on 
the O atom. You will get a dialog box with much to offer. Choose charge = -1. Click 
Ok. That should give you the desired ion. 

 
N. Naming structures 

To name a structure you have drawn, use the "Generate name for structure" tool. 
You can access this from the Tools menu (expand the Generate item), or from the 
button near the right hand end of the upper toolbar. 
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Fig. Screen shot to show how ChemSketch names a 
structure. In this case, I drew a 3-C chain, added a fourth 
C at the middle position and then changed it to a Cl. I 
then used the "Generate name for structure" tool; 
ChemSketch wrote the IUPAC name, 2-chloropropane, 
just below the structure. 

If you want to remove a name that ChemSketch has put on the screen... If naming 
was the most recent action, then using Undo (on the Edit menu) will remove it. 
More generally, click on the name to select it, then "delete" it (such as by using 
CTRL/X). 

The "Name" feature will name geometric isomers of alkenes using the E,Z system. 

Example. Draw 2-butene. Name it. ChemSketch seems to draw the E isomer (which 
is trans), by default, and it properly names it as the E isomer. Now, put a Cl at the 2-
position (replacing the H). Replacing an H with a Cl switches the ranking at this 
position (relative to the methyl group). Name the new compound; it is now, properly, 
named as Z. 

 
O. SMILES and InChI 

SMILES and InChI are both ways to describe a chemical structure in simple text 
characters. 

SMILES = Simplified Molecular Input Line Entry Specification. 
InChI = (IUPAC) International Chemical Identifier. 

This is not the place to try to explain them, but if you want to try them, they are 
available. Both are available from the Tools menu; expand the Generate item, and 
you will see SMILES and InChI commands. There are commands for structure-to-
code and code-to-structure. 

 
P. Import and export (file types) 
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In the Section 3D structures, for RasMol we made use of the ability of ChemSketch 
to save (export) a file in another file format. In this case, we used the MOL format, 
thus making the file suitable for use with the RasMol program. 

In fact, ChemSketch can Open (or Import) and Save (or Export) files using 
several formats. Many of these are file formats used by other programs that deal with 
chemical structures. For these File menu commands, the file type choices are 
available in the usual dialog box that comes up for choosing file name and type. 

Open vs Import? In earlier versions of ChemSketch, the Open command was for 
the ChemSketch file format, and Import was used for other file formats. Starting 
with version 10, the functions of Import are duplicated in Open. That is, the two are 
now equivalent. I recommend use of the more common Open command; Import 
remains as a legacy command for those who remember it from early versions. 
Similarly, Save As and Export are now equivalent. (What about Save and Save 
As? Save is intended for saving a new copy of an existing file, with the same name, 
type, and location. Save As is intended when you want to change something. For a 
new file, the two commands become equivalent; that is, using Save will bring up 
the Save As dialog box.) 

Starting with v 10, ChemSketch can save structures as PDF files. This feature is 
available from the File menu, Save As command. [This does not work for 3D 
models (i.e., from the 3D module).] There is also a button for this, on the upper tool 
bar, next to the Print button. It looks like the common Adobe Acrobat logo and is 
labeled Export to PDF. 

A somewhat related operation is the use of ChemSketch structures in Microsoft 
Word. To do this, copy the desired information from the ChemSketch screen in the 
usual way. Then, in Word, use Paste Special (Edit menu) to insert the information 
into a Word document. 

 
Q. Antialiasing 

Antialiasing makes lines and edges appear smoother on the screen. Information on 
how to turn on this feature was introduced in the section Getting and installing 
ChemSketch; scroll down to Settings, at the end of that section. Whether it is on or 
off by default varies with the version; in version 14, it seems to be off. 
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The smoothing is applied as part of displaying the structure; it is not stored in the 
file. Thus, one can gain the benefit of antialiasing with pre-existing files, and can 
turn it on or off as desired. 

Since antialiasing is a display feature, not intrinsic to the drawing, it may or may not 
be included when you copy a structure to another application. A true screen capture 
will include the smoothing. On the other hand, copying the structure and pasting it 
into Word or Powerpoint (with Paste Special) does not include the smoothing. (The 
free program IrfanView contains a good screen capture feature. IrfanView is 
at https://www.irfanview.com/.) 
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2. PKSolver 

It is a menu-driven add-in program for Microsoft Excel written in Visual Basic for 

Applications (VBA), for solving basic problems in pharmacokinetic (PK) and 

pharmacodynamic (PD) data analysis. The program provides a range of modules for 

PK and PD analysis including noncompartmental analysis (NCA), compartmental 

analysis (CA), and pharmacodynamic modeling. Two special built-in modules, 

multiple absorption sites (MAS) and enterohepatic circulation (EHC), were 

developed for fitting the double-peak concentration time profile based on the 

classical one-compartment model. 
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3. PCP Disso 
For calibration curve, percent drug release, model fitting and F2 factor from the dissolution studies. 
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4. Design-Expert® software (DX13) 

Design-Expert 13 (DX13) is a software tool that can be used to optimize 
products and processes. It offers a variety of statistical tools, including:  

1. Two-level factorial screening designs: Helps identify the most important 
factors that affect a product or process  

2. General factorial studies: Helps find the best combination of categorical 
factors  

3. Response surface methods (RSM): Helps find the best process settings for 
optimal performance  

4. Mixture design techniques: Helps find the ideal recipe for a product 
formulation  

5. Logistic regression: Helps analyze binary data, such as whether a process is 
pass/fail  

6. Poisson regression: Helps fit more accurate models when the response is a 
count data  

7. Multiple analyses: Helps model all responses in different ways for easy 
comparison 
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Dr. Amit Kasabe demonstrating and operating of the Design-Expert 13 
(DX13) is a software tool to the M. pharmacy students.  

 

       
 
 

      Dr. Amit Kasabe 
       Subject Teacher                                                                                  

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

7.3.1 - Portray the performance of the Institution 

in one area distinctive to its priority and thrust 



Post Name Examination Paper / Subject Chairman Important Dates

Chairman

 Appt NO. 
23105493

S.Y. B.Pharmacy (2018 
Patt) 

(Theory)

BOS:Pharmaceutics

*23105493*

Physical Pharmaceutics - II 
(Theory) Paper-Physical 
Pharmaceutics - II (Theory) 
(BP403T) ,
Sem IV

Khade Prashant Hanumant 
Pune District Education Association Pune 
District Education Association's 
Shankarrao Ursal College of 
Pharmaceutical Sciences And Research 
Centre Addr: 15/2A/1/1 Near Zensar IT 
TowerKharadi Pune Ta: Pune 
(corporation Area) Dist: Pune
8888872264

--

Sir/ Madam,

Khade Prashant Hanumant

Pune District Education Association Pune District Education Association's Shankarrao Ursal College of 
Pharmaceutical Sciences And Research Centre Addr: 15/2A/1/1 Near Zensar IT TowerKharadi Pune Ta: Pune 
(corporation Area) Dist: Pune

Mobile No. : 8888872264 Email : phkhade@gmail.com

1. The University Authorities have been pleased to appoint you for the Chairman, in the subject of :-

2. This appointment is based on certain assumptions and subject to respective provisions of Maharashtra Public Universities Act, 2016 
 and Statutes/ Ordinances, Rule and Regulations framed thereunder.
            It shall be obligatory on every teacher and on the non-teaching employee of the University, affiliated, conducted colleges, 
community colleges or recognized institution to render necessary assistance and service in respect of examination of the university 
and evaluation of students as prescribed by statutes. If any teacher or non-teaching employee fails to comply with the order of the 
university or colleges or institution , in this respect, it shall be treated as misconduct and the employee shall be liable for disciplinary 
action.in case of failure on the part of the teacher or non-teaching employee of any affiliated college, conducted college , 
community college or recognized institution, to comply with the order of the university in this respect, the vice-chancellor shall have 
power to take an appropriate action against them, which may include imposing penalties including suspension of approval to the 
appointment of a teacher, as may be prescribed by Statutes.

3. Please put yourself in communication with your Chairman immediately in regard to the meeting of the paper setting.

4. If required, you will be called by the Director, Central Assessment Programme for Central Assessment.

5. Please intimate the Director,Board of Examination and Evaluation , Savitribai Phule Pune University, Ganeshkhind, Pune 411 007, 
in case you are holding the other appointments of this University, if any.

6. Any change in the address, phone no., email address etc may please be communicated to both, the Chairman and the                     
Co-ordination Section, Examination Branch, Savitribai Phule Pune University, Ganeshkhind, Pune-7.

7. The TA/DA will be paid only to those paper-setters who will attened the meeting of the paper-setters on the invitation from the 
concerned chairman.  Travel by car for attending meeting is not allowed.

8. Please read and adhere to the enclosed important instructions.

9. The chairman should produce his order while submitting question papers to strong room section. 

I seek your co-operation.

Phone :020-25621440/25621447
Fax : 020-25621441
Email : 
ar.coordination@pun.unipune.ac.
in
Web : http://www.unipune.ac.in

CO-ORDINATION SECTION
Ganeshkhind, Pune - 411 007
Maharashtra (INDIA)

Savitribai Phule Pune University

23042100051
*23042100051*

First half of the year,2023

Formerly University Of Pune

21/04/2023 01:00

THIS IS A COMPUTER-GENERATED DOCUMENT AND IT DOES NOT REQUIRE A SIGNATURE. THIS  DOCUMENT 
SHALL NOT BE INVALIDATED SOLELY ON THE GROUND THAT IT IS NOT SIGNED.

1 of 2

12/29/2024 3:42:39 PM



Thanking You Yours,

      Director,Board of Examination and Evaluation

For early payment of examination remuneration work through ECS, you are requested to update your BCUD online teacher profile 
with Bank Account details. Also submit printed copy of same at the time of paper setting meeting. For details contact 020-25601388

To,
The Principal/Directors,
             You are requested to relieve the teachers for paper setting. Also requested to communicate names of the teacher/s 
who remain absent for the work of paper setting, the said information is required for submission to the University 
Authorities for necessary action under the provisions of section 48(4) of the maharashtra Public Universityes Act,2016.

Paper setter payment will done through automated  NEFT/RTGS  service for which  please update your pancard ,bank account 
details and bank IFSC code in your teacher profile.`

Course Code Course Name Subject Code Subject Name

11318 B. PHARMACY (2018) BP403T Physical Pharmaceutics - II 

Chairman has to attend  meeting before 45 mins  of schedule.

THIS IS A COMPUTER-GENERATED DOCUMENT AND IT DOES NOT REQUIRE A SIGNATURE. THIS  DOCUMENT 
SHALL NOT BE INVALIDATED SOLELY ON THE GROUND THAT IT IS NOT SIGNED.

2 of 2

12/29/2024 3:42:39 PM



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

7.3.1 - Portray the performance of the Institution 

in one area distinctive to its priority and thrust 



PDEA 

Shankarrao Ursal College of Pharmaceutical Sciences & 

Pune Districts Education Associations 

Pune, Maharashtra, India 

Research Centre, Kharadi, Pune-14. 

Lat 18.5502829 

Long 73.94937° 

Kharadi, Pune, Maharashtra 411O14, India 

21/06/23 09:37 AM 

A Report on 
Yoga and Meditation Session 

The institute organized a session on Yoga and Meditation" in association with Shree Yogvarga. 

The session was conducted by Mrs. Kamal Nanaware, Yoga Teacher of Shree Yogvarga Institute, 

Pune. All the students actively participated in the seminar, total 131 students were present during 

this session. This activity was coordinated by Mrs. Trusha P. Shangrapawar. 

Moinuddin Shaikh S/0 1, Eon Free Zone Rd, EON Free Zono, 

(21" June 2023) 

Mrs. Trusha P. Shangrapawar 
Cultural Co-ordinator 

GPS Map Camera 

Mrs. Kamal Nanaware, Yoga Teacher of Shree Yog-varga Institute conducting yoga and 

meditation session 
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Glimpse of Yoga session and meditation session 

Mrs.Trusba P. Shangrapawar 
Cultural Co-ordinator 
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7.3.1 - Portray the performance of the Institution 
in one area distinctive to its priority and thrust 



  दनांक : २१ Sep २०२३संदभ .-िव.िव.मं. २०२३-२४/१२४

ित ,
मा. ाचाय,
पुणे िज हा िश ण मंडळ शंकरराव उरसळ कॉलेज ऑफ 
फामासुटीकल साय स अँड रसच सटरखराडी. प ा: 
१५/२अ/१/१ झे सार आयटी टॉवर जवळ खराडीपुणे-४११ 
०१४ ता.: पुणे (महानगर पािलका ह ) िज: पुणे िपनकोड: 
411014

िवषय : कमवीर भाऊराव पाटील कमवा व िशका योजना मा यता.

महोदय/महोदया,
  आप या तावास अनुस न शै िणक वष २०२३-२०२४ क रता कमवीर भाऊराव पाटील कमवा व िशका योजना राबव याबाबत िव ाथ  
िवकास मंडळ ािधकरणास आपण पाठिवलेला ताव मा य कर यात आला आहे. या योजनेबाबत या सव सुधा रत िनयम व अट चे पालन क न 
वरील योजना आप या महािव ालात ऑग ट २०२३  ते माहे फे ुवारी २०२४ ा दर यान या कालावधीत राबिवणे अप रहाय आहे.        

1. योजनेत सहभागी येक व सव िव ा याना; यांनी केले या य  कामाचा मोबदला ( ित िव ाथ  ित तास पये ४५/- या माणे एका 
दवशी जा तीत-जा त ३ तासापयतच) काम केले या येक मिह यानंतर व रत संबंिधत येक /  सव  िव ा या या बँक खा याम येच 

लगत या पुढील मिह यात १२ तारखेपयत जमा करणे अिनवाय आहे.
2. या योजने या िनयमावलीनुसार येक महािव ालय/प रसं थेतील िव ाथ  िवकास मंडळाचे रा ीयीकृत बँकेम ये माननीय ाचाय व 

िव ाथ  क याण अिधकारी यां या संयु  वा रीने वतं  खाते असणे आव यक आहे.  (या संयु  खा याचा उपयोग फ  िव ाथ  
िवकास मंडळाकडूनच मंजूर झाले या या व इतर सव  योजनां या अनुदानाचे िवतरण व खच करणेसाठी करावा.)

3. िव ा याचे मानधन िवतरणाची संपूण या िह " महािव ालय / प रसं थेने या योजनेसाठी िनि त केले या रा ीयीकृत बँक 
खा यामधून  िव ा या या बँक खा याम ये " याच प तीने असणे अिनवाय आहे. या िविहत प ती िशवाय इतर कोण यािह  कारे/ 
प तीने  िव ा याचे मानधन िवतरण अनु ेय नसून  ते अ ा  मानले जाईल व संबंधीत लेखे अि वकृत कर यात येतील. 

4. कमवीर भाऊराव पाटील कमवा व िशका योजने या िनयमावलीनुसार या योजेतील सहभागी िव ा याना यांचे मानधन येक 
मिह या या समा ीनंतर ता काळ लगत या मिह या या १२ तारखेपयत यां या बँक खा यात जमा करणे अिनवाय आहे. असे न झा यास 
या या मिह याचे अदा केलेले मानधन लेखापरी णातून वगळले जाईल आिण िव ापीठाकडून अशा िवलंब केले या मानधनाचे अनुदान 

िमळणार नाही.  
5.  िव ाथ  िवकास मंडळा या िनदशानुसार सदर योजनेत सहभागी िव ा याना एकूण जा तीत जा त तीन तासापयतच काम देता येईल. 
6. सदर योजनेतील सहभागी िव ा याना माचे मह व व एकूण व प ल ात ये यासाठी आळीपाळीने कायालयीन व े ीय कामकाज दे यात यावे.
7. योजनेतील सहभागी िव ा याना परी ा कालावधी व सावजिनक सु ा सोडून काम दे यात यावे.
8. सदर योजना आप या महािव ालयात फे ुवारी २०२४ अखेर या दर यान या कालावधीतच  राबिवणे अनु ेय आहे. 

       या योजने या अंमलबजावणीसाठी योजने या चिलत सव िनयम व अट चे कोण याही तरावर उ लंघन झा यास या योजनेची 
मा यता त भावी र बातल होऊन याबाबतची शासक य/आ थक सुर ा मक व पाची सव जबाबदारी महािव ालय/प रसं थेची 
असेल. िव ाथ  िवकास मंडळ ािधकरणा या िनयमावलीत न राहता उप मासंबंधी झाले या कायवाहीचा व वा षक ले यांचा वा षक 
लेखा परी णा यावेळी िवचार केला जाणार नाही. कळावे, िह िवनंती.

संचालक (अित र  कायभार), 
िव ाथ  िवकास मंडळ

आपला,

टप: १).योजने या मागदशक त वांम ये काही बदल झा यास वतं पणे कळिव यात येईल.
        २).मागील शै िणक वषात या योजनेअंतगत आपणास िव ापीठाकडून अनुदान ा  झाले अस यास आिण आप या महािव ालयाने या 

ािधकरणास आप या महािव ालया या बँक खा याबाबत मािहती पाठिवलेली असेल तर 'कमवीर भाऊराव पाटील कमवा व िशका' 
योजनेसाठीची  थम ह याची र म . ३७५००/- 'RTGS' ारे आप या महािव ालया या बँक खा यात जमा केली जाईल.

Name on Account Account No Bank Name Branch Name IFSC Code
PDEAs SUCOS AND RC 
KHARADI S W O

6415101000881 Canara Bank KHARADI CNRB0006415

PC127
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Pune District Education Association’s
Shankarrao Ursal College of Pharmaceutical Sciences & Research

Center Kharadi, Pune -14

Details of Submission of Industrial Training Report by Final Year
B. Pharm (Sem-VIII) students of

Academic Year 2023-2024.

Roll
No. Name of the Students

Name of the Organization Duration

1 Atole Akanksha Shivaji
Chandrika Hospital in Shri
Harneshwar medical , Pune

10-12-2023 to 10-01-2024

2 Badhe Payal Santosh
Santosh Medical Store ,
Khodade Hospital, Jawala,
Ahemednagar

9-01-2024 to 9-02-2024

3 Bavdhane Nilam H
Rajhans Medical in Jijai
Hospital, Khamgaon, Pune

9-01-2024 to 9-02-2024

4
Bhosale Gitanjali
Pandurang

Surya Multi-Speciality
Hospital, Paranda

5-06-2024 to 5-07-2024

5
Bochare Shrinath
Rangnath

Sarvadnya Hospital 15-12-2023 to 15-01-2024

6 Bohra Sayam Sunil Sarvadnya Hospital 15-12-2023 to 15-01-2024

7 Choudhari Abhijeet Shivlal Kilitch Drug Ltd. 15-12-2023 to 15-01-2024

8 Choudhary Yogesh K Eisen Pharaceuticals 15-12-2023 to 15-01-2024

9 Dhale Rushikesh Krishna Kilitch Drug Ltd. 15-12-2023 to 15-01-2024

10 Dhumal Siddhant Vikas
T.Walker's Pharmaceutics
PVT. LTD

6-6-2024 to 6-07-2024

12 Dolare Sakshi Popat
Shrishali Medical stores,
Mohol

9-01-2024 to 09-02-2024



13 Dombe Akshada Nilkant
Janseva General Hospital ,
pune

01-07-2024 t 01-08-2024

14 Dorage Shreya Dattatray
Jaywant Nurshing Home,
Pune

13-06-2024 to 13-07-2024

15 Dumbre Jagruti Sandeep
Dr. Awari Hospital Shri
Krushna Pharmacy,
Chandan Nagar , Pune

2-03-2024 to 2-04-2024

16 Gaikwad Nikita Nana
Shree Siddhivinayak
Hospital, Pune

6-06-2024 to 10-07-2024

17 Gaikwad Utkarsh Ramesh Eisen Pharaceuticals 5-03-2024 to 5-04-2024

18 Ghavate Siddhi Ashok
Vighneshwara hospital,
Manjari

12-04-2024 to 12-05-2024

19 Ghule Sonali Balasaheb
Vighneshwara hospital,
Manjari

12-04-2024 to 12-05-2024

20 Ghule Vaibhavi Dattatray
Navjeevan Hospital,
Manjari, Pune

11-03-2024 to 11-04-2024

21 Girase Pallavi Mahendra
Tuljai Hospital, Awhalwadi,
Pune

5-02-2024 to 5-03-2024

22 Gosavi Subhash Santosh
Mahavir Medical in Arihant
Hospital, Ahmednagar

11-12-2023 to 11-01-2024

23 Gund Rutuja Santosh
Jagdale Hospital and
Siddhivinayak medical,
Pune

05-01-2024 to 05-02-2024

24 Hambir Utkarsha Gulabrao Shri Seva Medico, Pune 15-06-2024 to 15-07-2024

25 Hole Shubham Mahadev
Rajhans Medical in Jijai
Hospital, Khamgaon, Pune

11-12-2023 to 11-01-2024

26 Holkar Nikita Rajaram
Heartbeat Multispeciality
Hospital, Ahmednagar

09-01-2024 to 09-02-2024

27 Ingole Rajlaxmi Sanjay Medicine World, Pune 9-01-2024 to 9-02-2024

28 Jadhav Shivjeet Ramesh Eisen Pharaceuticals 10-01-2024 to 10-02-2024



29 Jadhav Vaibhav Santosh Eisen Pharaceuticals 05-03-2024 to 5-04-2024

30 Jagtap Hrishikesh Sudam Sanjivani Hospital , Pune 09-01-2024 to 9-02-2024

31 Jagtap Rutvik Anil
Inamdar Multispeciality
Hospital, Pune

1-01-2024 to 01-02-2024

33 Kadam Manish Ramdas Kilitch Drug Ltd 05-03-2024 to 05-04-2024

34 Kale Vinit Ganpat Eisen Pharaceuticals 09-01-2024 to 9-02-2024

35 Kamble Esha Rajendra
Shri Samarth Speciality
Hospital

05-06-2024 to 05-07-2024

36 Kaspate Shubham Biru
Inamdar Multispeciality
Hospital, Pune

01-02-2024 to 01-03-2024

37 Khaladkar Tejas Santosh Jagdale Hospital, Pune
09-01-2024 to 09-02-
2024

38 Kharabe Khushi Rohidas Biovet Privet Limited, Pune 18-06-2024 to 18-07-2024

39
Kirtane Vaibhav
Vishwajeet

Eisen Pharaceuticals, Pune 10-01-2024 to 10-02-2024

40 Kolhe Gauri Ishwar
Padamshree Nursing Home
Hospital

12-04-2024 to 12-05-2024

41 Lagad Jai Anil
Phoenix Hospital ,
Keshavnagar

12-04-2024 to 12-05-2024

42 Mane Rohini Vijaykumar Harpale Hospital, pune 05-06-2024 to05-07-2024

43 Mane Sakshi Sayaji
Child Care Hospital,
Solapur

22-06-2024 to 22-07-2024

44 Mate Mayur Rameshwar
Dr. Awari Hospital Shri
Krushna Pharmacy,
Chandan Nagar , Pune

15-06-2024 to 15-07-2024

45 Mohite Aditya Rahul
Eisen Pharamaceuticals ,
Pune

05-03-2024 to 05-04-2024

48
Naiknavare Deepali
Radhkisan

Kale Hospital, Pune 01-06-2024 to 01-07-2024



49 Narvekar Snehal Sukhdev
Eisen Pharmaceutical CO.
(PVT.) LTD

17/11/2023 to 16/12/2023

52
Patange Vaibhav
Narayanrao

Kale Hospital , Pune 15-06-2024 to 15-07-2024

53 Pawar Pratiksha Prashant
Rajhans Medical in Jijai
Hospital, Khamgaon, Pune

09-01-2024 to 09-02-2024

54 Pawar Vikas Rajaram Kale Hospital, Pune 15-06-2024 to 15-07-2024

56 Raje Vasundhara Satish Dwarkadhish Clinic, Pune 19-12-2023 to 19-01-2024

57
Rajpurohit Srushti
Harisingh

Sure Health Clinic in Bharat
Chemist, Pune

09-01-2024 to 09-02-2024

58
Raskar Laukik
Chandrakant

Sahara Multi- Speciality
Hospital, Pune

06-07-2024 to 6-08-2024

59 Rathod Bharat Kilitch Drug Ltd. 15-12-2023 to 15-01-2024

60 Salunke Shreya Pravin
Sure Health Clinic in Deep
Medical Chemist, Pune

05-02-2024 to 05-03-2024

61 Sawant Aarti Ramdas
Inamdar Multispeciality
Hospital, Pune

09-01-2024 to 09-02-2024

63 Shewale Pranali R
Langhe Multispecialty
hospital in Sarvadnya
Medical Store

05-08-2023 to 05-11-2023

64 Solanke Prathamesh N
Sahara Multi- Speciality
Hospital, Pune

06-06-2024 to 06-07-2024

66 Tambe Vaibhav Vishnu
Dr. Awari Hospital Shri
Krushna Pharmacy,
Chandan Nagar , Pune

02-02-2024 to 02-03-2024

67 Thite Rohan Nitin Jadhav Hospital, Pune 05-12-2023 to 05-06-2024

68 Thokal Sakshi Bhaskar
Smarth Medical, Pranav
Hospital, Kedgaon

01-02-2024 to 15-03-2024

70
Thopate Saurabh
Dattatraya

Kanifnath Medical, Pune 12-04-2024 to 12-05-2024

71 Thorat Suyash Vikas Sanjivani Hospital , Pune 09-01-2024 to 09-02-2024



Mrs. Deepika Prajapati Dr. Ashok Bhosale

Coordinator Principal

72 Todmal Bhakti Nilesh
Eknath Hospital in Minerva
Medico & General Store,
Pune

05-08-2023 to 05-11-2023

73 Vidhate Rachna Suresh Kale Clinical, Jalna 01-06-2024 to 01-07-2024





















































 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 

7.3.1 - Portray the performance of the Institution 
in one area distinctive to its priority and thrust 



PDEA 
Pune Districts Education Associations 

Shankarrao Ursal College of Pharmaceutical Sciences & 

Google 

Research Centre, Kharadi, Pune-14. 

Pune, Maharashtra, India 

A Report on 

Lat 18.548408° 

GWww.F8X New Nurf, Jama Masjld, Kharadi Gaon, Kharadi, Pune, Maharashtra 411014, India 

Long 73.946718 

A Seminar on "Communication Skills" -13h January 2024 
The institute organized a seminar on "Communication Skills" in association with Clinitech 
Support Institute. The seminar was delivered by Mr. Abhay Thube, Director of Clinitech Support 

Institute Pune. All the students actively participated in the seminar, total of 62 students were 

present during the seminar. This activity was coordinated by Mrs. Trusha P. Shangrapawar. 

13/01/24 10:37 AM GMT +05:30 

Mrs. Trusha P. Shangrapawar 
Cultural Co-ordinator 

GPS Map Camera 

Skills 

URSAL 

Page 1 of 1 
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Mr. Abhay Thube, Director of Clinitech Support Institute Pune delivering a seminar on Communication 
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Research Centre, Kharadi, Pune-14. 
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PDEA 
Pune Districts Education Associations 

Shankarrao Ursal College of Pharmaceutical Seiences & 

Research Centre, Kharadi, Pune-14. 

A Report on 
A Seminar on �Assertive Verbal Skilis" (29th February 2024) 

The institute organized a seminar on "Assertive Verbal Skills" in association with Let's Speak 

Institute. The seminar was delivered by Mrs. Krutanjali Kanse, Director of Let's Speak Institute 
Pune. All the students actively participated in the seminar, total 30 students were present during 
the seminar. This activity was coordinated by Mrs. Trusha P. Shangrapawar. 

Mrs. Trusha P. Shangrapawar 
Cultural Co-ordinator 

Pune, MH,India 
Kharadi South Main Road, kharadi, Pune, 411014, 
MH, India 
Lat 18.548020, Long 73.943760 
02/29/2024 03:04 PM GMT+05:30 
Note: Captured by GPS Map Camera 

oPS Map Camer 

Mrs. Krutanjali Kanse, Director of Let's Speak Institute Delivering Lecture on *Assertive Verbal Skills" 

Page 1 ofi 
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PDEA e eet tr heeri 

President 

Ajit Pawar 

Vice President 

Rajendra Ghadge 

Hon. Secretary 

Adv. Sandeep Kadam 
Senate Member, SPPU, Pune 

Treasurer 

Dy. Secretary 

L. M. Pawar 

Principal 
Dr. Ashok Bhosale 

SHANKARRAO URSAL COLLEGE OF PHARMACEUTICAL 
SCIENCES AND RESEARCH CENTRE 

Approved by 
Affiliated to 

Adv.shanrao Deshmukh 

Dae: 21 2I02Y 

Recognised by : Government of Maharashtra D.T.E.Institute Code :PH 6385 MSBTE Code :2143 

I Website : www.pdeasubpharm.edu.in t E-mail: sUCopsrc 2009@yahoo.co.in 1 Tele.: 020-27013835 

To, 

Pune District Education Association's 

:Pharmacy CoUncil of India, New Delhi. All India Councl for Technical Education 
: Savitribai Phule Pune University (PU/PN/Pharmy384/2009), Code 1235 
Maharashtra State Board of Technical Education. 

Director. 

Mrs. Krutanjali Kanase 

Pune. 

Let's Speak Institute 

Kharadi, Pune - 411014 

1.0pm. 

Dear Madam, 

Subject: Regarding organization of seminar on Soft Skills and Language 

and Communication Skills under Capacity Building Program on 29h February 2024 at 

9823620854). 

As per our conversation, I am pleased to extend an invitation to you for organization of 

seminar on Soft Skills and Language and Communication Skills under Capacity Building 

Program on 29h February 2024 at 1.0pm. 

Thanking you! 

R 

As we are aware that, you are an eminent speaker in the field of Soft Skills and Language 

and Communication Skills, and in an endeavor to raise the importance of these skills in 
our students, we take this opportunity to invite you to impart these skills in our students 

on 29th February 2024 at 1.0pm. So, we look forward to your presence and co-operation. 
(For any query please contact to coordinator Mrs. Trusha P. Shangrapawar 

Ref No: SUCOPSRC/9 S7 I2023- 2024 

(Dr. Asho7 Bhosal�) 
Princifln Cipal 

PDEA'S Shankarrao Ursal College 
of Pharmaceutical Sciences & 

Re_earch Centre, Kharadi, Pune-14. 
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PDEA 

President 
Ajit Pawar 

Vice President 

Rajendra Ghadge 

Hon. Secretary 

Adv. Sandeep Kadam 
Senate Member, SPPU, Pune 

Treasurer 

Dy. Secretary 
L.M. Pawar 

Principal 
Dr. Ashok Bhosale 

SHANKARRAO URSAL COLLEGE OF PHARMACEUTICAL 
SCIENCES AND RESEARCH CENTRE 

Approved by :Pharmacy Council of India, New Delhi. All India Council for Technical Education 
Affiliated to Savitribai Phule Pune University (PU/PN/Pharm/384/2009), Code 1235 

Dale:2704 

Adv.AMohanrao Deshmukh 

Recognised by : Government of Maharashtra D.T.E.Institute Code : PH 6385 

Pune District Education Association's 

I Website : www.pdeasubpharm.edu.in E-mail :sucopsrc_2009@yaho0.co.in 1 Tele. : 020-27013835 

To, 

Mrs. Krutanjali Kanase 

Director, 

Let's Speak Institute 

Pune. 

Kharadi, Pune - 411014 

Respected Mam, 

Yours Sincerely, 
Thanking you with regards. 

Thanking Letter 

At the outset, we wish to convey our sincere gratitude towards you for organizing the 
series of seminars on Soft Skills and Language and Communication Skills for the 
academic year 2023-2024. Your expertise in the field has been truly applicable for all 
students to implement in their daily life. We are looking forward for having much more 
interaction with you in the future. 

MSBTE Code :2143 

Dr. Ashe Dal 
PDEA'S Shankarrao Ursal College of Pharmaceutical Sciences & 

Keciel 

Ref. No: SUCOPSRC I 

Maharashtra State Board of Technical Education. 

Research Centre, Kharadi, Fuine-14. 
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PDEA 
Pune Districts Education Associations 

Shankarrao Ursal College of Pharmaceutical Sciences & 

Research Centre, Kharadi, Pune-14. 

A Report on 
A Seminar on "Communication and Team Work" 

(27th January 2024) 

Pune, Maharashtra, India 
GWXV+5HQ, Thite Nagar, Kharadi, Pune, Maharashtra 411014, India 
Lat 18.548003* 

Long 73.943919° 

27/01/24 01:47 PM GMT +05:30 

Mrs. Prusha P. Shangrapawar 
Cultural Co-ordinator 

The institute organized a seminar on �Communication and Team Work" in association with 

Clinitech Support Institute. The seminar was delivered by Mrs. Smita Thube, Co-Founder of 

Clinitech Support Institute Pune. All the students actively participated in the seminar, total 53 

students were present during the seminar. This activity was coordinated by Mrs. Trusha P. 

Shangrapawar. 
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PDEA'S Shankarrao Ursal College 

of Pharmaceutical Sciences & 
Research Centre, Kharadi, Pune-14. 

13



]2 

15 

Jai 
Sauwash 

3 Holkor Nita 
Dunbre Jagui 
Saleshi olare 
Nhito .Gaicvad 

1.Tantap Hrishikealh 
Amor 

19-

2) 
22 

13Duyationuda 

Yash shego koy 
Vasundbarg. Rye 

I6 Ghole Vaubhavi 
Ghcie"gonali 

93 

24. 

Dhale Dhale Rushtkesh 
20 Hote hubho 

Boidhonelom 

2s 
26 

2 
28 

R1|2024 
Comimum ctiom 4 Team wak 

Name 

2.9 

Lagad 
Thapate 

30 

32 

mande. 

Kohan Taite 
Soutobh S pobale 
Sumt. ohite 

hokal Salcshi 
Sabhash Gosavi 
Pasar Pratiksha 
Kitane Vaibhav 

khakd kog Tejas 
Jadhav Vaibhav 

Siddharnt Dhura 

Q023- 2024 

Rohan Tite 

Yeot 
Final yenn 8Phan 

penale þhorm 
inalshera 

Final Bpho 

And A$fhem 

Fénal 
Finl YB-Pharritarte 
fina), Y. BPhamsaZ 

tipe Ye gr B.Phan 

final year 
finalyeor 

fina 

CoLLEGE OFa 

fual ea BPhae 
fnal eoh BPhat 

Paathaah SolauKFiaayar 

AACst ron 

Finl B-Phon ltg. 

pinal y. 8. fhan au 

inalyen 

CENTSS 

B Pham 

ohule 

finalyeaBhAsaibhe 

final year B pham aa 

Shauatr 
Rushi 

hole 

-SR2 

14



Shande. 
Putuys 

RESEAR 

wers R23endet the 
Umi eeh Suppa3 Jmttte Total G3 stuclen 

Concuctee by a Sormuta Thube co. toum 

ECueaionA 
CES 
RSA 

tfie-44. 
Us & tottege 

ham 

Sphaim 

tiy8-Phaimi 
TyB. PhomHrtt 

T8:Phatrr 

TyBPhat 
TBP hory 

TY B: phar 

Jemim 

TYB 

phacm: 

T:YB Pha[m 

Ý, BPhasn 

Principal 
Researeh-¬, 

of PharCia 
PDEAS 

TY!. 

Imstitute 
mms 

TY:B fham 

Teat 

21RShangpaw 

paikwasd 

komesi Psalte A. 
18- Meag ade ngarashwei 

I4Toradma Gaurav 
&hide Reuya 

SuYNase Và sant Rutuja 
14Thonbae Yagiraj Vrfthal 

hivrgj Avhale 

Ani 

NHRO 

ayohit 

Hax st Gabhoe 
Il: Siadhovth od ke 

Crlnd. Aragha 
Mayei Aoi Chouogi 

Pqekae uea Hanumanr 
A2u Aihard Dni 

R poTe Pranaiv 

csalihi herisli uuaolhoi TYBMham 

Name 

)S. 

12. 

& 

3 

SANO 

Star 

Shir JagdsesSanjay 

15



PDEA 
Pune Districts Education Associations 

Shankarrao Ursal College of Pharmaceutical Sciences & 
Research Centre, Kharadi, Pune-14. 

Cultural Co-ordinator 

A Report on 

A Seminar on "Stress Management" 

Mr Trasha P. Shangrapawar 

(29th February 2024) 
The institute organized a seminar on �Stress Management" in association with Let's Speak 

Institute. The seminar was delivered by Mrs. Krutanjali Kanase, Director of Let's Speak Institute 

Pune. AIl the students actively participated in the seminar, total 44 students were present during 

the seminar. This activity was coordinated by Mrs. Trusha P. Shangrapawar. 

Pune, MH,lndia 
Kharadi South Maln Road khrdi, PneV014, 
MH. India 
Lat 18.547998, Long 73.943804 
02/29/2024 02-55 PM GMT+05:30 
Note: Captured by GPS Map Camera 

mera 

Mrs. Krutanjali Kanase, Director of Let's Speak Institute Delivering Lecture on �Stress Management" 

Page 1 of1 
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PDEA'S Shankarrao Ursal College 
of Pharmaceutical Sciences 

Research Centre, Kharadi, Pune-14. 
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Pune District Education Association's 
SHANKARRAO URSAL COLLEGE OF PHARMACEUTICAL 

SCIENCES AND RESEARCH CENTRE 

Principal 
Dr. Ashok Bhosale 

Approved by 
Affiliated to 

Pharmacy Council of India, New Delhi. All India Council for Technical Education 
Savitribai Phule Pune University (PU/PN/Pharm/384/2009), Code 1235 
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Recognised by : Government of Maharashtra D.T.E.Institute Code :PH 6385 
Website: www.pdeasubpharm.edu.in E-mail : sucopsrc_2009@yahoo.co.in 

Dale: 2] |2/2024 

Adv. Mahanrao Deshmukh 

To, 

Mrs. Krutanjali Kanase 

Director, 

Let's Speak Institute 

Pune. 

Kharadi, Pune 411014 

Dear Madam, 

9823620854). 

Thanking you! 

MSBTE Code :2143 

Subject: Regarding organization of seminar on Soft Skills and Language 

and Communication Skills under Capacity Building Program on 29th February 2024 at 

1.0pm. 

Tele. :020-27013835 

(Dr. Ashok BhÍsale) 
PrircibBl cipal 

EAL TH 

As per our conversation, I am pleased to extend an invitation to you for organization of 

seminar on Soft Skills and Language and Communication Skills under Capacity Building 

Program on 29th February 2024 at 1.0pm. 

PDEA'S Shankarrao Ursal College 
of Pharmaceutical Sciences & 

Re_earch Centre, Kharadi, Pune-14. 

ARAD PuN 

As we are aware that, you are an eminent speaker in the field of Soft Skills and Language 

and Communication Skills, and in an endeavor to raise the importance of these skills in 
our students, we take this opportunity to invite you to impart these skills in our students 

on 29h February 2024 at 1.0pm. So, we look forward to your presence and co-operation. 
(For any query please contact to coordinator Mrs. Trusha P. Shangrapawar 

Ref. No.: SUCOPSRC /Q S7 2023-224 
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President 

Ajit Pawar 

Vice President 

Rajendra Ghadge 

Hon. Secretary 

Adv. Sandeep Kadam 
Senate Member, SPPU, Pune 

Treasurer 

Dy. Secretary 

L.M. Pawar 

Principal 
Dr. Ashok Bhosale 

SHANKARRAO URSAL COLLEGE OF PHARMACEUTICAL 

Approved by 
Affiliated to 

Date 

Ad.ohanrao Deshmukh 

Recognised by : Government of Maharashtra D.T.E.Institute Code : PH 6385 MSBTE Code :2143 

Website :www.pdeasubpharm.edu.in E-mail :sucopsrc_2009@yahoo.co.in 1 Tele.: 020 -27013835 

To, 

7 22024 

SCIENCES AND RESEARCH CENTRE 

Director, 

Pune District Education Association's 

Pharmacy Council of India, New Delhi. All India Council for Technical Education 

: Savitribai Phule Pune University (PU/PNZPharm/384/2009), Code 1235 
Maharashtra State Board of Technical Education. 

Mrs. Krutanjali Kanase 

Pune. 

Let's Speak Institute 

Respected Mam, 

Kharadi, Pune - 411014 

Thanking 
Yours Sincerely, 

Thanking Letter 

At the outset, we wish to convey our sincere gratitude towards you for organizing the 

series of seminars on Soft Skills and Language and Communication Skills for the 

academic year 2023-2024. Your expertise in the field has been truly applicable for all 
students to implement in their daily life. We are looking forward for having much more 

interaction with you in the future. 

you with regards. 

Dr. AshgHCpal 
PDEA'S Shankarrao Ursal College of Pharmaceutical Sciences & 

Research Centre, Kharadi, Fune-14. 

Kecuel 

PARMACTFOR 

Rel No: SUCOPSRCI S2023-2024 
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PDEA 
Pune Districts Education Associations 

Shankarrao Ursal College of Pharmaceutical Sciences & 
Research Centre, Kharadi, Pune-14. 

A Report on 
A Seminar on "Cyber Security" (6" February 2024) 

Mr. Aniket Barkade delivering seminar on Cyber Security 

Mis. frusha P, Shangrapawar Cultural Co-ordínator 

Page 1 of 1 

RSAL 

KHAR ARAOL 

The institute organized a seminar on Cyber Security" in association with Global Computer 
Academy. The seminar was delivered by Mr. Aniket K. Barkade, Director of Global Computer 

Academy. All the students actively participated in the seminar, total 53 students were present 
during the seminar. This activity was coordinated by Mrs. Trusha P. Shangrapawar. 

cOLLE GE AO ESEARria 

2009 

PuNE.41191 

.PRINCIPAL 
P D.E.A's 

Shankarrao Ursal College of 
Pharmaceutical Sciences & Research Centre 

Khareti, Pune-411014 

9
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Affiliated to :Savitribai Phule Pune University (PU/PN/Pharm/384/2009), Code 1235 
Recognised by : Government of Maharashtra 
D.TE.Institute Code : PH 6385 1 Webste: www.pdeasubpharm.edu.in 1 E-mail: sucopsrc_ 2009@yatioo.co in 

Date: 2024 

To, 

Pune District Education Association's 

Kharadi, Tal. Haveli, Dist. Pune - 411014 
All India Council for Technical Education. 
Pharmacy Council of India, New Delhi. 

Director 

Mr. Aniket Barkade 

Pune. 

Global Computers 

Respected Sir, 

Adv. Sandeep Kadam At the outset, we wish to convey our sincere gratitude towards you for organizing 
Seminar on Cyber security under Capacity Building Program for the academic 
year 2023-2024. Your expertise in the field has been truly applicable for all students 

to implement in their future. We are looking forward for having much more 

Adv. Mohanrao DeshmUkn interaction with you in the future. 

Thanking Letter 

Thanking you with regards. 

Yours Sincerely, 

Dr. Ashok Bhosale 
PRINCIPAL 
P D.E.A's 

Shankarrao Ursal College of 
Pharmaceutical Seiences & Research Centre 

Kharadi, Pune-411014 

Phone: 020-27013835 

Ref No. SUCOPSRC 746C0)| 2023-20 24 

Reive 

Institt1te Copy 
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To, 

Ms. Sakshi Waghmare 

Kharadi, Pune - 411014 

Content Moderator and Digital Marketing Specialist, 

Global Computers, 
Pune. 

Respected Ma'am, 

Subject: Invitation for Seminar on Internet Access and Security under Capacity 

Building Program 

Greetings from PDEA's Shankarrao Ursal College of Pharmaceutical Sciences and 
Research Centre! 

Thank you for considering our invitation. 

Yours sincerely 

We are pleased to invite you to deliver a seminar on "Internet Access and Securiy" as part 

of our Capacity Building Program for the academic year 2023-2024. Your expertise in 
content moderation and digital marketing makes you an ideal speaker to enlighten our 
students on this significant topic. The seminar aims to enhance students' knowledge in 

internet security and its application in their professional and personal endeavours. The 
session is scheduled for 19th March 2024 at 12.0 pm at our college premises. 

We would be honoured by your presence and look forward to your guidance in making 
this session an enriching experience for our students. Please let us know your availability 
at the earliest to facilitate further arrangements. 

PRINCIPAL 
PB.E. A's 

aRI 

Ref. No: SUCOPSRCI PoCa) 120 24-2024, 

Shanerrao Ursal Colege of 
Pharmeceutical Sciences & Research Centre 

NAAC Accredited B++Grade 

Khered, Pune-411014 

Receiveel 

Institute Copy 
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Kharadi, Tal. Haveli, Dist.. Pune - 411014 
: All India Council for Technical Education, 

Pharmacy Council of India, New Deihi. 

Pune. 

Ms. Sakshi Waghmare 

Content Moderator and Digital Marketing Specialist, 

Global Computers, 

Thanking Letter 

Respected Sir, 

Thanking you with regards 

Yours Sincerely, 

At the outset, we wish to convey our sincere gratitude towards you for organizing 

Seminar on Internet Access and Security under Capacity Building Program for 

the academic year 2023-2024. Your expertise in the field has been truly 

applicable for all students to implement in their future. We are looking forward 

for having much more interaction with you in the future. 

Dr. Ashok Bhosale 
PRINCIPAL 
P D.E. A's 

Shankerrao Ursal College of 
Pharmeceutical Sciernces & Research Centre 

Kharedi, Pune-411014 

Phone: 020- 27013835 
Ref. No.: SUCOPSRC /32A |202h-202 

ESMAR 

Received. 

Institute Copy 

D.T.E.Institute Code : PH 6385 I Website : www.pdeasubpharm.edu.in E-mail: sucopsrc_2009@yahoo.co.in 
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PDEA 
Pune Districts Education Associations 

Shankarrao Ursal College of Pharmaceutical Sciences & 

Research Centre, Kharadi, Pune-14. 

A Report on 
Yoga and Meditation Session 

(29th February 2024) 

Pupe, MH,India 

The institute organized a session on "Yoga and Meditation" in association with Motherhood 

Hospital on 29th February 2024. The session was conducted by Ms. Gauri Khandave, Yoga Trainer 
and Pharmacist at Motherhood Hospital, Pune. Total 29 students were present during this session. 

This activity was coordinated by Mrs. Trusha P. Shangrapawar. 

Iharadi South Main Road Kharadi, Pune, 411014 
MH, Andi 
L18548250, Long 7343776 
02/29/202A 09. 40 AM GMT 05:30 

Note: Captured by GPS Mapamera 

oa Mep Camera 

session 

RI 

Page 1 of2 

EAatn Ah 
cOLLE GE OF 

AESEARCL 

Ms. Gauri Khandave, Yoga Trainer and Pharmacist at Motherhood Hospital conducting Yoga and Meditation 

K:ARADA, PUNE. 

2009 

PBARA. CEN 



Pune, MH, 

Mrs. Trusha P. Shangrapawar 
Cultural Co-ordinator 

Khard South Mh Road, Kharad, Pun, 471014, 
MH,r 

ut 18548222 Long 73.943798 
02/29/2024 09:38 AM GMT+05:30 
Note: Captured by GPS Map Camera 

Glimpse of Yoga and Meditation Session 

Page 2 of2 
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Kharadi, Pune - 411014 

Ms. Gauri Khandave 

Pune. 

Yoga Trainer (Dumbellbee Gym) 

Dear Madam, 

D.T.E.Institute Code : PH 6385 

Subject: Regarding organization of Yoga and Meditation session under 

Capacity Building Program on 29th February 2024 at 8.30am. 

Thanking you! 

(Dr. Ashok Bhosale) 
Ppirdipal 

MSBTE Code :2143 

As per our conversation, I am pleased to extend an invitation to you for organization of 

Yoga and Meditation session under Capacity Building Program on 29th February 2024 at 
8.30am. 

Ref. No: SUCOPSRC/ 8SS I2023-20 

As we are aware that, you are an eminent speaker and Yoga Trainer in the field Life Skills, 
and in an endeavor to raise the importance of these Life skills in our students, we take this 

opportunity to invite you to impart these skills in our students on 29th February 2024 at 
8.3( 30am. So, we look forward to your presence and co-operation. (For any query please 

contact to coordinator Mrs. Trusha P. Shangrapawar- 9823620854). 

PDÉA'S Shankarrao Ursal College 
of Pharmaceutical Sciences & 

Research Centre, Kharadi, Pune-14. 

au 
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Ms. Gauri Khandave 

Respected Mam, 

Kharadi, Pune - 411014 

Yoga Trainer (Dumbellbee Gym) 

Yours Sincerely, 

Thanking you with regards. 

At the outset, we wish to convey our sincere gratitude towards you for organizing Yoga 
and Meditation session under Capacity Building Program for the academic year 2023 
2024. Your expertise in the field has been truly applicable for all students to implement 
in their daily life. We are looking forward for having much more interaction with you 
in the future. 

Dr. Ashok Bhosale 

Thanking Letter 

Principal 

Ref. No: SUCOPSRC/ 8S6 I2023-202-4 

PDEA'S Shankarrao Ursal College of Pharmaceutical Sciences & Research Centre, Kharad1, Pune-14. 

Website : ww.pdeasubpharm.edu.in E-mail: sucopsrc_2009@yahoo.co.in 1 Tele. : 020-27013835 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

7.3.1 - Portray the performance of the Institution 

in one area distinctive to its priority and thrust 
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